Page Breaks
A page break is a marker in Word that tells your document that whatever follows
the break should begin at the top of a new page.
Imagine you are at the end of a chapter in your manuscript and you want to start
the next chapter on a new page. A lot of times students use the return key to get
down to the top of the next page.

If you turn on the paragraph
markers in the document,
returning down looks like this:

The problem with returning to a new page is that, when you make edits or add text,
Word doesn’t know to keep your subsequent text at the top of the next page.
Keeping with our example,
let’s say you add text to the
end of Chapter 1, and so
Chapter 1 now ends at the
bottom of the page, not the
middle. See what happens to
the beginning of Chapter 2.
Chapter 2 slides down the
page, and your major heading
is no longer top-aligned.
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Page Breaks
Page breaks are also important when you want to separate pages that include
vertically-centered text. For example, in your Preliminary Pages, your Certificate of
Approval, Epigraph, and Dedication all need to be vertically centered on the page.
The easiest way to make sure these pages stay centered is to use page breaks.
To insert a page break, simply press shift + fn + return.
Or, you can insert a page break this way:
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Section Breaks
Although section break may be a little bit trickier than page breaks, understanding
how they work can save you a lot of time.
Ever wonder how you can shift both the presence and appearance of page
numbers? Section breaks.
Insert a section break by
clicking Insert, Break,
Section Break (Next
Page). This will start your
next section on the
following page.

To shift from non-numbered Preliminary Pages (Title Page, Copyright, and
Certificate of Approval) to numbered Preliminary Pages (everything that follows),
insert a section break at the bottom of your Certificate to separate it from the page
that immediately follows, using the step above.
Double click on your footers, and you will see the different sections:
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Section Breaks
To ensure that each section has its own distinct footer style (where your page
number will go), click on the Section 2 footer. Here you will see the Same as
Previous:

This tab lets you know that Word is set up to keep the document’s footers
consistent, despite the introduction of different sections. To turn this function off,
simply unclick Link to Previous, found here:

This breaks the connection between the footers in different sections, allowing you
to place different page number styles into your footers:
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Page Numbers
You are now ready to insert page numbers into your Preliminary Pages, starting
with the page immediately following your Certificate of Approval. The first page
number should be a lower-case Roman numeral ii.

•

Once you’ve clicked on Page Numbers, click on the Format button:

•

Then format your page number as a Roman numeral, starting at ii:

Set the Number format
to lower-case Roman
numerals, and then set
the Start at at ii.

Next, page numbers in the body of your manuscript should begin with a ‘1’.
•

To begin, insert a section break between your last Preliminary Page
and the beginning of you first chapter. Make sure you unclick Same as
Previous, and format your page numbers to begin on ‘1’, using the
steps outlined above.
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Table of Contents
Here we explain the steps of generating a Table of Contents with Microsoft Word.
In your manuscript, different sections will have different headings. Your chapter
titles, for example, will be major headings (Heading 1), while sections within the
chapter may be set off by second-level headings (Heading 2).
•

First, apply Styles to your headings. Creating a Table of Contents depends on
creating headings that Word will know to put in your list.

•

Highlight the text you want to serve as a heading.

•

For major headings, under the Home tab, click on Heading 1 in Styles to
assign that style to your heading.
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Table of Contents
For second-level subheadings, do the same thing. Highlight the text you want
to serve as a second-level heading, and assign it a Heading 2 value.

  
  
  
•

Once you have assigned all your headings their appropriate Style, you can
generate your Table of Contents. Under the Insert tab, click Index and
Tables. This will bring up the options that allow you to insert a Table of
Contents or List of Tables or Figures.

•

Your Table of Contents will include all the headings you assigned throughout
your manuscript text. Click on the page where you want to include your
Table of Contents and press OK.
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Table of Contents
•

Updating your Table of Contents to make sure page numbers are correct and
the headings are accurate is easy. Simply click anywhere on the table, and
the Update Table tab will appear.

•

Click the Update Table tab to open the Update Table of Contents dialog box,
which gives you the choice of updating page numbers or the entire table:

If you have made any revisions to your thesis, update your Table of Contents
to ensure it reflects the most recent version of your thesis.
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List of Tables / List of Figures
For the purpose of explanation, we will focus on creating a List of Tables, since the
List of Figures works in exactly the same way. Note: Macs use the language of
Table of Figures to refer to these Lists.
•

Create a caption for each of your tables. Creating a List of Tables depends on
creating captions that Word will know to put in your list. Click on the Insert
tab in your toolbar, and then click on Caption.

•

The Caption dialog box will give you a choice of what sort of caption to
create: Equation, Figure, or Table. For our purposes, choose Table.

•

In the box below Caption in the same dialog box, type in your table title.
Press OK. Do this for every table caption in your thesis.

•

Under the Insert tab,
click Index and Tables.
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List of Tables / List of Figures
•

From here, you can finalize how your List of Tables will look. Make sure you
click Show Page Numbers and Right Align Page Numbers. You can also
choose the Tab Leader (the dots that connect the caption entry with its page
number) there.

•

As with the Table of Contents, you can update a List of
Tables to reflect any changes you’ve made to your thesis.
Simply click anywhere on your List, press control, and
then click Update Field:

•

You now have
the option of
updating page
numbers only
or updating
the entire
table.
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Headings and Captions
If you don’t like the formatting of your headings or captions (say, you prefer 12point font to 9-point, or you want bolded font instead of italics), you can change
the formatting using the Styles tab under HOME tab. This will eliminate the need to
manually format your headings and captions.
For purposes of example, we will focus on heading styles, knowing that you can
change any sort of style (headings, captions, titles) you’d like. They all work in
the same way.

Click on the
Styles icon in
your toolbar.
Or, click on the icon beside the Styles choices under the Home tab.

This will bring up your Styles descriptions, and from here you
can alter how your headings appear.  
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Headings and Captions
Hover your mouse over the Heading 1 listing, and a dropdown box will appear. This
will allow you to modify the heading format:

Click on Modify Style.

About one-third of the way down the Modify Style box are Formatting options,
which show you current heading styles. You may make changes here and then click
OK.
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Common Formatting Errors
This portion of the document provides information about common formatting errors
that can affect your Table of Contents and List of Tables / List of Figures. It includes
illustrations to help you identify these errors and basic information on how to fix
them.
Below is a list of common errors and where they can occur within your thesis:

Common Formatting Error

Table of
Contents

List of Tables
/
List of Figures

1. Listing pages that precede the Table of
Contents

X

2. Use of upper-case Roman numerals

X

3. Use of boldface, italics, or underlining
for stylistic purposes

X

X

4. Inconsistent spacing

X

X

5. Descriptive titles (entries or table/figure
captions) run into the page number
column

X

X

6. Page numbers do not right align

X

X

There is also a final recommendation about keeping your Table of Contents simple.
After all, the more detail you include, the greater chance you have of introducing
errors.
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Common Formatting Errors
COMMON ERROR 1:
Listing Pages that Precede the Table of Contents

Correction

Note: Preliminary pages that come before your Table of Contents
(Acknowledgements, Abstract, Public Abstract, etc.) should not be listed. Make sure
the preliminary pages before your Table of Contents are not marked as major
headings. This way Word will not place them in your Table of Contents. Or, if you
do mark them as major headings, make sure to carefully highlight the entries in the
Table of Contents and delete them once the Table has been constructed.
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Common Formatting Errors
COMMON ERROR 2:
Use of Upper-Case Roman Numerals

Correction

Note: The Table of Contents should reflect the page numbering convention you’ve
used in your preliminary pages: lower-case Roman numerals. If you create an
automated Table of Contents using Microsoft Word, your Table of Contents will
reflect all of the page number formatting you’ve used.
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Common Formatting Errors
COMMON ERROR 3:
Use of Boldface, Italics, or Underlining
(for non-scientific or scholarly purposes)

Correction

Note: Although you may choose to use certain conventions in your headings within
the manuscript text, these conventions (such as bolded font or italics) should not
be replicated in the Table of Contents OR in the List of Tables / List of Figures. You
may manually remove bolded, italicized, or underlined font from your Table of
Contents and List of Tables / List of Figures once it has been constructed.
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Common Formatting Errors
COMMON ERROR 4:
Inconsistent Spacing

Correction

Note: While you may be tempted use spacing to set off different elements of the
thesis in your Table of Contents, entries should be spaced in a way that is
consistent and visually pleasing.

17

Common Formatting Errors
COMMON ERROR 5:
Descriptive Titles Run into the Page Number Column

Correction

Note: Sometimes longer entries overlap with or run into their corresponding page
numbers. An easy solution is to let Word generate your Table of Contents, as it will
not allow text to intrude on the page number column. If you craft a Table of
Contents by hand and this error occurs, use the space bar to drop the interfering
text down to the next line.
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Common Formatting Errors
COMMON ERROR 6:
Page Numbers Don’t Right Align

Correction

Note: The Word automated Table of Contents function will automatically ensure
your page numbers are right-aligned.
If you construct a Table of Contents manually, you can align your page numbers
through setting your Tabs to ensure the Leader Lines (…) are consistent.
1. Type your entries and their page numbers into your Table of Contents
(for example, LIST OF TABLES iii).
2. Highlight the entries, click on Paragraph in the Toolbar, and then click on
Tabs.
3. For a page layout with 1-inch margins, set the Tab stop position at 6.5.
4. Set the Alignment at Right.
5. Set the Leader at 2.
6. Click Set at the bottom of the Tabs box, or else the settings will not hold.
7. Click OK, and un-highlight the text.
8. The Ruler at the top will now show a carrot symbol, which marks the 6.5 stop
position you just created.
9. Go to your Table of Contents, press Tab, and Word will automatically
separate your entries and their corresponding page numbers with leader
lines.
10.The numbers will automatically right align.
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Common Formatting Errors
FINAL RECOMMENDTATION:
Keep It Simple!

Alternative

Note: Because it is easier to introduce errors the more details you include, keep it
simple.
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